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Warranty and Disclaimer

The use of the deliverables (e.g. software, application examples, target boards, evaluation boards, starter kits, schematics, engineering 
samples of IC’s etc.) is subject to the conditions of Fujitsu Semiconductor Europe GmbH (“FSEU”) as set out in (i) the terms of the 
License Agreement and/or the Sale and Purchase Agreement under which agreements the Product has been delivered, (ii) the 
technical descriptions and (iii) all accompanying written materials.

Please note that the deliverables are intended for and must only be used for reference in an evaluation laboratory environment.

The software deliverables are provided on an as-is basis without charge and are subject to alterations. It is the user’s obligation to fully 
test the software in its environment and to ensure proper functionality, qualification and compliance with component specifications.

Regarding hardware deliverables, FSEU warrants that they will be free from defects in material and workmanship under use and service 
as specified in the accompanying written materials for a duration of 1 year from the date of receipt by the customer.

Should a hardware deliverable turn out to be defect, FSEU’s entire liability and the customer’s exclusive remedy shall be, at FSEU´s sole 
discretion, either return of the purchase price and the license fee, or replacement of the hardware deliverable or parts thereof, if the 
deliverable is returned to FSEU in original packing and without further defects resulting from the customer’s use or the transport. 
However, this warranty is excluded if the defect has resulted from an accident not attributable to FSEU, or abuse or misapplication 
attributable to the customer or any other third party not relating to FSEU or to unauthorised decompiling and/or reverse engineering 
and/or disassembling.

FSEU does not warrant that the deliverables do not infringe any third party intellectual property right (IPR). In the event that the 
deliverables infringe a third party IPR it is the sole responsibility of the customer to obtain necessary licenses to continue the usage 
of the deliverable.

In the event the software deliverables include the use of open source components, the provisions of the governing open source license 
agreement shall apply with respect to such software deliverables. 

To the maximum extent permitted by applicable law FSEU disclaims all other warranties, whether express or implied, in particular, but not 
limited to, warranties of merchantability and fitness for a particular purpose for which the deliverables are not designated.

To the maximum extent permitted by applicable law, FSEU’s liability is restricted to intention and gross negligence. FSEU is not liable for 
consequential damages.

Should one of the above stipulations be or become invalid and/or unenforceable, the remaining stipulations shall stay in full effect.

The contents of this document are subject to change without a prior notice, thus contact FSEU about the latest one.
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CD Contents

Software (Installation)
FLASH USB DIRECT Programmer
FLASH Serial Programmer
SerialPortViewerAndTerminal 
Fujitsu OpenOCD Starter (GUI)
Fujitsu USB Assistant

Documents
Schematic:          ‘SK-FM3-48PMC-USBSTICK’
User Guide:         ‘SK-FM3-48PMC-USBSTICK’
Data Sheet:          MB9A310K Series
Manual:                Peripheral Manual
Manual:                Technical Reference Manual
Manual:                Flash Programming Manual
Application Note: Virtual Com Port; Example Files: Virtual Com Port
Application Note: Using Fujitsu USB Assistant
Application Note: FSEU USB Host
Application Note: FujitsuUsbLib (PC)
Application Note: FSEU Embedded USB Device Library
Application Note: OpenOCD GUI Frontend
Application Note: USB Host Mass Storage Bootloader 3
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CD Contents (continued)

Examples
Further examples are available on the CD and on our website
Note: Please copy the examples to your local drive!

Download the latest version from the following website:
http://mcu.emea.fujitsu.com/mcu_tool/detail/SK-FM3-48PMC-USBSTICK.htm

Open Questions? Contact:  mcu_ticket.FSEU@de.fujitsu.com
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Overview

Introduction
About the SK-FM3-48PMC-USBSTICK
Requirements
The hardware
Installation of Serial Port Viewer & Terminal

Try yourself
USB Host and Device
Open OCD Debugger
IAR-Embedded Workbench
MCU Programming Via USB
Create Own USB Applications

Contacts

All Rights Reserved.© Fujitsu Limited 2011
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About the SK-FM3-48PMC-USBSTICK

The SK-FM3-48PMC-USBSTICK includes a low-cost evaluation 
board 
based on the Fujitsu FM3 microcontroller MB9A310k Series

The MB9A310K Series includes the following features:
Up to 128 KByte Flash Memory
Up to 16 KByte RAM
Up to 4 LIN-USART-I²C interfaces
USB-Host/-Device interface
Timers (ICUs, OCUs,  PPGs, others)
Up to three 12 bit ADC
External interrupts
Low Power Mode
DMA Controller (8 channels)
Quadrature Position/Revolution Counter

All Rights Reserved.© Fujitsu Limited 2011
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About the SK-FM3-48PMC-USBSTICK

Features of the SK-FM3-48PMC-USBSTICK board:

Microcontroller MB9AF312K
1x USB to serial converter (Type-B connector)
JTAG integrated
1x USB-MiniHost (Type-A connector)
1x USB-Device (Type-B connector)
Optional USB On-The-Go (assembly option for USB Mini connector)
3x LED controlled with PWM
1x ‘User’-button
1x ‘Reset’-button
All 48 pins routed to pin-header
Power supply via USB 
Voltage filter for ADC
Light sensor

All Rights Reserved.© Fujitsu Limited 2011
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Requirements

Embedded Development & MCU Flash Programming
Windows 2000 , Windows XP or Windows7
Administrator Rights
For some applications .NET Framework 2.0 and higher is required

PC Frontend Development
Microsoft Visual C# Express
Microsoft .NET Framework 2.0 and higher

Virtual Com Port Example
Windows 2000,XP, Vista or Windows 7 (32-bit)
Mac OS X or Linux

HID Communication Example
Windows 2000,XP, Vista or Windows 7 (32- and 64-bit)
Microsoft .NET Framework 3.5 and higher
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The Hardware

Main features

USB-Connector
USB A/B conector 

For a detailed description please see User Manual

RUN-Switch
To switch between USB 
programming mode and 
run mode

Pin Headers
Connect MCU Pins with 
own peripherals

Pin Headers
Connect free MCU Pins 
with own peripherals

FM3 MB9AF312K
Series MCU
MB9AF312K 4MHz Oszillator Reset button

User LEDs

User Button

Light Sensor

FTDI Chip
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The Hardware
Top side

All Rights Reserved.© Fujitsu Limited 2011

10

USB-Connector
USB A/B conector 

Voltage Regulator
For internal 3,3V

Run/Prog Switch
To switch between USB 
programming mode and 
run mode

FM3 MB9AF312K
Series MCU
MB9AF312K

4MHz Oszillator

RGB LED

User Button

Light Sensor

Pin Headers
Connect free MCU Pins 
with own peripherals

Reset button

FTDI Chip

Pin Headers for UART

Pin Headers for JTAG

USB Debug
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The Hardware
The jumpers (bottom side)
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JP1- JP2: JTAGPWR
Default:Closed

JP3: Use SW1 
Default:Closed

JP4, JP5, JP8: RGB LEDs 
Default:Closed

JP6: Light Sensor
Default:Closed

JP7: USB Universal ID
Default:Closed

JP9: USB BUS low/high
Default:1-2

JP10: USB BUS Enable
Default:Closed

JP11: AVRH Enable
Default:Closed

JP12: USB Overcurrent
Default:Closed

JP13: USB Host
Default:closed

JP14-JP15: Use  32KHz 
Quartz
Default:Open
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The Hardware
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Pin Pin-name
Pin-Function on 
SK-FM-100PMC 

Pin Pin-name
Pin-Function on 
SK-FM-100PMC 

1 VCC VCC 13 C N.C.

2 P50/ INT00_0/AIN0_2/ SIN3_1 14 VCC VCC

3 P51/INT01_0/BIN0_2/SOT3_1 15 P46/ X0A 32KHz Crystal

4 P52/INT02_0/ZIN0_2/SCK3_1 16 P47/ X1A 32KHz Crystal

5 P39/DTTI0X_0/ADTG_2 17 INITX Reset

6 P3A/RTO00_0/TIOA0_1/RTCCO_2/SUBOU
T_2 R-RGB LED 18 P49/ TIOB0_0

7 P3B/RTO01_0/TIOA1_1 19 P4A/ TIOB1_0

8 P3C /RTO02_0 /TIOA2_1 G-RGB LED 20 PE0/ MD1

9 P3D/ RTO03_0/ TIOA3_1 21 MD0 SW3
Run Mode

10 P3E/ RTO04_0/ TIOA4_1 B-RGB LED 22 PE2
X0 4MHz Crystal

11 P3F/ RTO05_0/ TIOA5_1 23 PE3
X1 4MHz Crystal

12 VSS GND 24 VSS GND

• The microcontroller pins
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The Hardware

All Rights Reserved.© Fujitsu Limited 2011

13

Pin Pin-name
Pin-Function on 
SK-FM-100PMC 

Pin Pin-name
Pin-Function on 
SK-FM-100PMC 

25 P10/ AN00 Fotoresistor LDR 
03 37 P00/ TRSTX TRSTX

26 P11/ AN01/SIN1_1 /INT02_1/ FRCK0_2/ 
IC02_0/ WKUP1 USB Overcurrent 38 P01 /TCK / SWCLK TCK

27 P12/ AN02/ SOT1_1/ IC00_2 USB HOST Pull-
Down 39 P02 /TDI TDI

28 P13/ AN03/ SCK1_1/ IC01_2/ RTCCO_1/ 
SUBOUT_1 USB VBUS EN 40 P03 / TMS / SWDIO TMS

29 P14/ AN04/ SIN0_1/ INT03_1/ IC02_2 41 P04 /TDO /SWO TDO

30 P15/ AN05/ SOT0_1/ IC03_2 USB ID 42 P0F/ NMIX / CROUT_1 / RTCCO_0 
/SUBOUT_0 / WKUP0

SW2 
Switch

31 AVCC VCC 43 P61 / SOT5_0 / TIOB2_2 / UHCONX 
/DTTI0X_2 UHCONX

32 AVRH VCC 44 P60 / SIN5_0/ TIOA2_2 / INT15_1/ IC00_0/ 
WKUP3 USB VBUS INT

33 AVSS GND 45 USBVCC VCC

34 P23/ AN06/ SCK0_0/ TIOA7_1 46 P80/ UDM0 UDM0

35 P22 / AN07 / SOT0_0 / TIOB7_1 UART0 (TXD) 47 P81 /UDP0 UDP0

36 P21 / SIN0_0 / INT06_1 / WKUP2 UART0 (RXD) 48 VSS GND

• The microcontroller pins (continued)
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The Hardware
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• The Jumpers

Jumper Function Default

JP1 JTAGPWR Closed

JP2 JTAGPWR Closed

JP3 Use SW1 Closed

JP4 RGB LEDs Closed

JP5 RGB LEDs Closed

JP6 Light sensor Closed

JP7 USB ID Pin Closed

JP8 RGB LEDs Closed

JP9 USB BUS low/high 2-3

JP10 USB BUS enable Closed

JP11 AVRH Enable Closed

JP12 USB Overcurrent Closed

JP13 USB Host Closed

JP14 Use 32KHz Crystal Open

JP15 Use 32KHz Crystal Open
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Installation of Serial Port Viewer 
& Terminal

Install Serial Terminal 
Program: 
Serial Port Viewer  & Terminal

Click „Next“

Read and accept the 
disclaimer and click „Next“

All Rights Reserved.© Fujitsu Limited 2011
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Installation of Serial Port Viewer 
& Terminal

Choose a optional installation 
directory and click „Next“

Click „Next“

All Rights Reserved.© Fujitsu Limited 2011

16



Fujitsu Semiconductor Europe - http://emea.fujitsu.com/microelectronics

Installation of Serial Port Viewer 
& Terminal

Click „Install“

Click „Finish“ and the Serial 
Port Viewer & Terminal will be 
opened.

All Rights Reserved.© Fujitsu Limited 2011
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Installation of Serial Port Viewer 
& Terminal

The Serial Port Viewer & 
Terminal can be found as tray 
icon. Via right-click, the 
terminal for the specific com 
port can be opened.

All Rights Reserved.© Fujitsu Limited 2011
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1 2
1. Select Baud rate
2. Click red blinking „Disconnected“
button to connect



Fujitsu Semiconductor Europe - http://emea.fujitsu.com/microelectronics

Virtual Com Port Example

Used to communicate via 
CDC class
MCU source & binary
Examples\ sk-fm3-48pmc-
usbstick_usb_device_virtual
_com_port-v10

All Rights Reserved.© Fujitsu Limited 2011
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USB Host and Device (1)

Device Mode:
HID Communication

Host Mode:
Mass Storage
Mouse
Keyboard

Example:
sk-fm3-48pmc-usbstick_usb_host_device-vXX

All Rights Reserved.© Fujitsu Limited 2011
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USB Host and Device (2)

All Rights Reserved.© Fujitsu Limited 2011

21

USB Device connected to PC
LEDs turns off
Within example sk-fm3-48pmc-usbstick_usb_host_device-vXX
in folder „ forwindows\Binary“ the PC Demo can be found:
„ Fujitsu_UsbCom_Demo.exe“
LEDs, Sensors, Buttons and UART can be used via GUI
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USB Host and Device (3)
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USB Mass Storage via Host
Red LED turns on after a few seconds
Content of USB Stick will be displayed via UART 0, 115200,8,N,1
fujitsu.txt file will be written
Red LED turns off and green LED turs on for ready to disconnect
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USB Host and Device (4)
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USB Mouse via Host
Green LED turns on after a view seconds
Position will be displayed via UART 0, 115200,8,N,1
LEDs can be dimmed via X/Y movement and scroll wheel
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USB Host and Device (5)
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USB Keyboard via Host
Green LED turns on after a view seconds
Text typed will be displayed via UART 0, 115200,8,N,1
LEDs can be switched via key 1-3
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Create own USB Applications
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Using the Fujitsu USB Assistant
Easy to use, step by step
Creates USB Host / Device Projects
Combines microcontroller templates, board support and USB use case
Start installation of Fujitsu USB Assistant
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Installation of OpenOCD Debugger

1) Start installation of Fujitsu OpenOCD Starter (GUI)

2) The following window should appear.
Select your preferred language

3) Press Next

26
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4) Select „I accept agreement“ and 
press next
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Installation of OpenOCD Debugger
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5) Select the installation folder and 
press next

6) Select „Full installation“ push 
next

7) Select shortcuts folder and 
press next

8) Select „Create a desktop icon“
and „create quick launch icon“ and 
press next
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Installation of OpenOCD Debugger

9) Push „Install“ 10) Installation will begin

11) Select to Install Drivers, and 
push finish 12) Open the OpenOCD
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Installation of the USB-driver

Connect the SK-FM3-48PMC-USBSTICK via mini-USB (X5) to 
your PC
The Installation of the drivers will be done through OpenOCD. 
Only in case the following dialog box appears, follow the next 
steps.

Windows will ‘Found New Hardware: FT232R USB UART’ and 
the Hardware Wizard should start automatically

• Note: The dialog box may differ with different operating systems

29
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1) Ignore this dialog box
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Installation of the USB-driver

30
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2) Open OpenOCD
3) Push the button „Install Driver“

4) If a warning window 
appears click on „Continue 
Anyway“. This window could 
appear more than one time

5) READY!!!! 
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Installation of the USB-driver

Start the Device Manager of the Windows 
Control Panel

START -> Settings -> Control Panel 
Control Panel -> System -> Hardware -> 
Device Manager

Check ‘Ports’ for the assigned virtual COM-
port number

USB Serial Port (e.g.: COM2)

Open the Fujitsu‘s „SerialPort Viewer and 
Terminal“

Double click on the icon         of the taskbar.

It will show the opened ports, check for the 
assigned virtual COM-port number

USB Serial Port (e.g.: COM2)

All Rights Reserved.© Fujitsu Limited 2011

31

Ready!

There are two options to check that your installation was successful:
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Debugging with OpenOCD
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SK-FM3-176PMC-ETHERNET offers an on-chip debugger via 
USB X5

1. Connect the board on X15 to the USB-Port of your PC
2. Open OpenOCD
3. Select the sk-fm3-176pmc-ethernet in config file
4. Push Start Debug
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Debugging with OpenOCD

IAR Workbench configuration

1. Open the project you want to debug.
2. Go to Project->Options

All Rights Reserved.© Fujitsu Limited 2011
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3. Select Debugger
4. Select Setup
5. As driver select “GDB Server”
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Debugging with OpenOCD

IAR Workbench configuration
6. Select GDB Server
7. Type „127.0.0.1“ on the field of TCP/IP adress

8. Start debug in IAR Workbench (See next section)
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IAR Workbench Getting Started

Install EWARM from IAR-CD or download latest version from 
IAR Website

EWARM 30-day Evaluation Version
• http://supp.iar.com/Download/SW/?item=EWARM-EVAL

EWARM 32K Kickstart Version
• http://supp.iar.com/Download/SW/?item=EWARM-KS32

Start EWARM Workbench

All Rights Reserved.© Fujitsu Limited 2011
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IAR Workbench Getting Started
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Choose File → Open → Workspace
Select e.g. 

\\ Examples\sk-fm3-48pmc-usbstick_usb_device_virtual_com_port-v10\example\IAR\
sk-fm3-48pmc-usbstick_usb_device_virtual_com_port.eww
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IAR Workbench – Main Window
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IAR Workbench
Workspace on left side
of Workbench window

• Choose:
View→Workspace,
if hidden

• Open main.c on 
source files.

Source files on right
side of Workbench
window as tabbed
windows

Project can
alternatively be
opened by:
File→Open→
Workspace→*.eww 
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IAR Workbench – Menu Bar

Menu Bar

All Rights Reserved.© Fujitsu Limited 2011
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File Control 
(new, open, 
save, etc.)

Edit Control
(cut, copy, 

paste, undo, 
redo)

Configuration 
Control

(e.g. RAM or ROM 
debugging)

Navigation Control
(Find, Bookmarks, File 

Navigation, etc.)

Build Control
(compile, make, 

stop build)

Debug Control
(Breakpoint, start 
Debug w/ and w/o 

download)
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MCU Programming via USB

Step 1
Insert the CD ROM

Switch SW3 to Prog Mode

Step 2
Connect the evaluation board 
to the PC

All Rights Reserved.© Fujitsu Limited 2011
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Step 3
The hardware wizard will be 
opened.
Select „No, not this time“ and 
click „Next“

Select „Install the software 
automatically 
(Recommended)“ and click 
„Next“

All Rights Reserved.© Fujitsu Limited 2011
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MCU Programming via USB
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Step 3 (continued)
While asking for Windows 
Logo certification, click 
„Continue Anyway“

The driver installation was 
successful.

Step 4

Push finish

All Rights Reserved.© Fujitsu Limited 2011
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MCU Programming via USB
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Step 5
Find the virtual com port 
number via the device 
manager. It can be found in 
the „System“ Control Panel.

Select the „Hardware“ and 
click at „Device Manager“

All Rights Reserved.© Fujitsu Limited 2011
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MCU Programming via USB
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Step 5 (continued)
Open the tree „Ports (COM & 
LPT“ by clicking on the „+“.

Look for the „USB Port“ entry. 
In this case it is com port 4

All Rights Reserved.© Fujitsu Limited 2011
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MCU Programming via USB
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MCU Programming via USB

Step 5
Start the installation of the 
USB DIRECT Programmer

Click „Next“

Choose a optional installation 
directory and click „Next“

All Rights Reserved.© Fujitsu Limited 2011
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MCU Programming via USB

Step 5 (continued)
The USB DIRECT 
Programmer was now 
succesfull installed.

Step 6
Start the USB DIRECT 
Programmer from Start Menu

All Rights Reserved.© Fujitsu Limited 2011
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MCU Programming via USB

Step 7
Choose Target MCU
Enter the com port number

Open the firmware file
• Located in:

Examples\
sk-fm3-48pmc-usbstick_usb_host_device-vxx\
Example\IAR\output\release\exe

• Choose here
sk-fm3-48pmc-usbstick_usb_host_device.srec

All Rights Reserved.© Fujitsu Limited 2011
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MCU Programming via USB

Step 7 (continued)
Click at „Full Operation“

Do NOT reset the MCU and 
click at „OK“

The firmware was 
programmed.

47
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MCU Programming via USB

Step 8

Switch SW3 to RUN

Press the reset button

All Rights Reserved.© Fujitsu Limited 2011
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Further Steps

In order to learn more about Fujitsu’s microcontrollers

Visit our microcontroller website
• http://mcu.emea.fujitsu.com
• http://mcu.emea.fujitsu.com/mcu_product/detail/MB9AF312KPMC.htm
• http://mcu.emea.fujitsu.com/mcu_tool/detail/SK-FM3-48PMC-USBSTICK.htm

See our application notes
• http://mcu.emea.fujitsu.com/mcu_product/mcu_all_appnotes.htm

See our software examples
• http://mcu.emea.fujitsu.com/mcu_product/mcu_all_software.htm

Contact your local distributor …

for individual support
to register for our monthly FM3 seminar  
to order the latest ‘Fujitsu Micros DVD’ containing all information regarding 
Fujitsu’s 8-bit, 16-bit, and 32-bit microcontrollers

49
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Contacts - Distribution

European distributors

Anatec                                        www.anatec.ch
EBV Elektronik                          www.ebv.com
Farnell                                        www.farnell.com
Glyn                                            www.glyn.de , www.glyn.ch
Ineltek                                         www.ineltek.com
Melchioni Electronica               www.melchioni.it
PN Electronics                           www.pne.fr
Rutronik Elektronische             www.rutronik.com
Bauelemente

50
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Fujitsu Semiconductor Europe

http://www.fujitsu.com/emea/contact/microelectronics/salesoffices/

Germany (Headquarters)
63225 Langen Tel: +49 (0) 61 03 69 00

France
91300 Massy Tel: +33 (0) 1 64 47 97 00

Italy
20080 Milano Tel: +39 02 90 45 02 1

United Kingdom 
Maidenhead Tel: +44 (0) 1628 50 46 00

Hungary
1143 Budapest Tel: +36 1 471 21 29

Turkey
34180 Istanbul Tel: +90 212 557 18 81

World Wide Web
http://emea.fujitsu.com/microelectronics
http://mcu.emea.fujitsu.com
Contact:  mcu_ticket.FSEU@de.fujitsu.com
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EG-Konformitätserklärung /
EC declaration of conformity

Hiermit erklären wir, Fujitsu Semiconductor Europe GmbH, Pittlerstrasse 47, 63225 Langen, Germany
dass dieses Board aufgrund seiner Konzipierung und Bauart sowie in den von uns in Verkehr gebrachten 
Ausführung(en) den grundlegenden Anforderungen der EU-Richtlinie 2004/108/EC „Elektromagnetische Verträglichkeit“
entspricht. Durch eine Veränderung des Boards (Hard- und/ oder Software) verliert diese Erklärung ihre Gültigkeit!

We, Fujitsu Semiconductor Europe GmbH, Pittlerstrasse 47, 63225 Langen, Germany 
hereby declare that the design, construction and description circulated by us of this board
complies with the appropriate basic safety and health requirements according to the EU Guideline 2004/108/EC entitled 
’Electro-Magnetic Compatibility’. Any changes to the equipment (hardware and/ or software) will render this declaration 
invalid!

Note:
All data and power supply lines connected to this starter kit should be kept as short as possible, with a maximum 
allowable length of 3m. Shielded cables should be used for data lines. As a rule of thumb, the cable length used when 
connecting external circuitry to the MCU pin header connectors for example should be less than 20cm. Longer cables
may affect EMC performance and cause radio interference.
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Fujitsu Semiconductor Europe - http://emea.fujitsu.com/microelectronics

Recycling

Gültig für EU-Länder:
Gemäß der Europäischen WEEE-Richtlinie und deren Umsetzung 
in landesspezifische Gesetze nehmen wir dieses Gerät wieder zurück.
Zur Entsorgung schicken Sie das Gerät bitte an die folgende Adresse:

Valid for European Union Countries:
According to the European WEEE-Directive and its implementation 
into national laws we take this device back.
For disposal please send the device to the following address:

Fujitsu Semiconductor Europe GmbH
Warehouse/Disposal 

Monzastraße 4a
D-63225 Langen

This board is compliant with China RoHS
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